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Congratulations on your new Zelocity PureLaunch Ball Flight/Launch Monitor, the state-
of-the-art in golf performance monitoring.  We recommend that you read through these 
instructions in their entirety before beginning to set up and use the equipment.  You may 
want to keep this guide handy when using the PureLaunch the first few times.  Please 
contact us with any questions at 1-888-ZELOCITY or visit our website at 
www.zelocity.com. 
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PureLaunch Specifications 

 
General:   

• Launch monitor with two integrated Doppler-radar transceivers 
• Shot data transferred via USB connection to personal computer (not included) 
• PureLaunch computer software provided for end user interface and presentation 
• Outputs include Club Speed, Ball Velocity, Carry Distance, Power Transfer Ratio %, 

Launch Angle, and Ball Spin  
 

Applications:  Custom Club Making, Club Fitting, Advanced Golf Instruction, Serious Golfers 
 
Performance:  

• For use with right-handed and left-handed golfers 
• Indoor or outdoor use; No calibration required; Setup time less than 1 minute 
• Ball Spin measured using reflective-striped ball or calculated using non-striped ball 
• Integrated microphone for Club Speed measurement at impact 

 
Convenience:  

• Portable, compact design; Fold-out legs and carrying handle 
• 10 ft. USB cable provided for communication from computer to PureLaunch 
• No field maintenance required; One (1) year factory warranty; Repaired at factory 
• Operates using Battery or AC power outlet; Recharge ~ 10 hrs; Avg. Life ~ 6 hrs 

 
Construction:  

• Tubular steel frame with rugged ABS/PC plastic radomes and processor cover 
• Power switch, USB connector, AC power connector 
• External LED indicators for Power ON/OFF and Radar ARMED/NOT ARMED 

 
Power:  

• Removable, rechargeable 12V DC Ni-Cad batteries provided (2 provided)  
• 120V, 25W AC Power Transformer provided for recharging or AC operation 
• Input Voltage (auto-sensing): 90-135V at 50/60 Hz or 180-265V at 50/60 Hz 

 
Software:  

• Compatible with WinXP Home, WinXP Professional, Win2000 operating systems 
• PureLaunch software size: ~ 500 Kb 
• Screen resolution: 1024 by 768 pixels (minimum) 

 
Dimensions:  Standing: (H x W x D): 30 ¼” x 18” x 25”  

Folded: (H x W x D): 5 ½” x 18” x 34” 
Weight: 12.2 lbs, including 1.3 lb battery 
Shipping: (H x W x D): 12” x 36” x 31”; 26 lbs; One (1) unit 

per container 
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Environment:  
 

• Operating temperature: 40° to 120°F; 10% to 90% Relative Humidity 
• Non-operating storage conditions: -20° to 130°F; 10% to 90% Relative Humidity 
• Compliant with Federal Communications Commission (FCC) product regulations 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules.  These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation.  This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation.  If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures: 
-- Reorient the receiving antenna 
-- Increase the separation between the equipment and receiver 
-- Move the computer away from the receiver 
-- Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

DECLARATION OF CONFORMITY 
 

We, Zelocity Corporation, 
14500 N. Northsight Blvd., Suite 205 

Scottsdale, Arizona  85260 
Phone 480-556-6007 

 
declare under our sole responsibility that the product 

 
Zelocity PureLaunch 

 
complies with Part 15 of the FCC Rules.  Operation is 

subject to the following two conditions:  (1) this device 
may not cause harmful interference, and (2) this device 

must accept any interference received, including 
interference that may cause undesired operation. 
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Getting Started 

 
Before using your Zelocity PureLaunch, check to ensure that all components have been 
received.  A complete parts list for PureLaunch contains the following items. 
 

1. PureLaunch Launch Monitor 
2. PureLaunch Software CD  
3. Operating Instruction Guide 
4. AC Power Supply/Battery Charger 
5. Two (2) rechargeable batteries 
6. Universal Serial Bus (USB) cable 
7. Supply of ¼” - width reflective strips 

 

 
 

 
 
If you have not received these items or if any item appears damaged, contact your 
Zelocity salesperson. 

 
 

***ATTENTION***ATTENTION***ATTENTION***ATTENTION*** 
 

A ferrite bead is installed on the PureLaunch USB serial cable to reduce electromagnetic and 
radio-frequency interference.   

Any replacement cable must contain a properly installed ferrite bead. 

AC Power 
Supply/Battery 
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Supply of ¼” ‐
Width Reflective 

Strips

Batteries 

USB Cable with 
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Guide 
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The PureLaunch Launch Monitor 

 
The PureLaunch sits on the ground or floor, with the front of the unit pointed straight 
down the target line.   

 
The legs pivot around the frame and fold up for carrying and storage.  
Use the latch near the pivot hinge to secure the legs to the frame during 
transit.  Align the latch key by turning it until you begin to feel 
resistance.  Lock the key in place with a ¼ turn clockwise. 

 

 
 
 

Battery Charging 
 
The PureLaunch can be connected directly to an AC outlet or powered by battery.  The 
battery has an LED indicator light on the end and a small button which activates the light.  
The light emits the following colors: 
 
 GREEN:   Battery is charged 
 YELLOW:   Battery is nearing depletion & needs to be recharged 
 RED:  Battery is depleted 
 
Powering the PureLaunch with batteries in YELLOW or RED state may cause 
inconsistent readings. 
 
To charge the PureLaunch battery: 
 

1. Plug the power supply into a surge protected AC outlet. 
2. Plug the power supply connector into the socket on the PureLaunch battery. 
3. Charge the PureLaunch battery for a full 12 hours. 
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A fully charged battery will power the PureLaunch for 6 – 8 hours of typical operation.  
For your convenience, two (2) batteries have been included with the unit. 
 
 

Installing the PureLaunch Software 
 

***ATTENTION***ATTENTION***ATTENTION***ATTENTION*** 
 
Install the PureLaunch software program in the computer BEFORE connecting the unit to the PC 

via the USB cable the first time.  Once the program is installed, it will reside on the hard drive 
and does not have to be installed again. 

 
 
To install the program, insert the PureLaunch software CDROM included with your 
shipment and insert it into the CD drive of the computer to be used with the launch 
monitor.  Once the CD is inserted in the drive, the software will automatically begin the 
installation process.  The automatic installation wizard will run.  Follow the instructions 
given by the wizard to install the software.   
 
After the software programs are loaded, you will see the following prompt to connect the 
launch monitor to the computer.   
 
 

 
 

 
 

Follow the steps given in the next section to power ON the launch monitor.   
 
ATTENTION:  DO NOT click OK at this point. 
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Powering the PureLaunch 

 
If using the PureLaunch under AC power, plug the power supply connector into the 
socket on the underside of the controller box and the other end of the cord into the AC 
outlet.  If using battery power, insert the battery as shown in the picture, with the arrow 
on the battery pointed toward the front of the controller box.   
 

 
 
 
Power the unit ON using the power switch located on the right side of the bottom of the 
Controller Box, as shown.  The red LED indicator marked “POWER” is lit when the unit 
is powered up. 
 
Then plug the USB cable into the PureLaunch and then into the PC. 
 
After making the connection, WAIT for several seconds until Windows starts the Found 
New Hardware Wizard. 
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Select the option to [Install the software automatically] and Click Next.  All necessary 
device drivers are included on the PureLaunch installation CDROM.  Follow the wizard’s 
instructions to complete the driver installation process.   
 
Then go back to the ALERT window and click OK. 
 
 
 

 
 

 
 
 
Next, you will see the following PureLaunch installation wizard prompt for establishing 
communication with the device.   Select Start to establish communications between the 
PureLaunch and the PC.  Settings will be saved for future use of the PureLaunch. 
 

 
 
After the installation process is complete, you will see a Zelocity PureLaunch program 
icon (blue letter ‘Z’ with the word PureLaunch under it) on the computer’s desktop. 
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Getting Started with PureLaunch Software 

 
Selecting the Zelocity PureLaunch icon from the desktop will bring up the PureLaunch 
program.  The first time you enter the program, you will be prompted for Software Setup 
information shown in the pop-up window.   

 

 
 

1. The name, address, and phone data you enter will show up as contact information 
on the Session Summary Report.   

2. The Default Save Location is the preferred folder for filing your sessions.  You 
may override this location when saving files. 

3. The Title Bar Caption shows up in the header of each screen and in the program 
title bar at the top of each window. 

 
Once this data has been entered and saved, you will not be prompted for it again.  If you 
want to edit it later, choose the Options tab and select Software Setup. 
 
Next are instructions for setting up a PureLaunch session. 
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Setting Up a PureLaunch Session 

 
Use the Session tab to record Session and Golfer information. 
 

 
 
 
Next, enter up to four (4) Items being tested in this session.  If you have more than four 
items, simply group the items to be tested into sets of up to four each, then create 
additional sessions and relate them using similar file names.    
 
Items to be tested can be anything you choose, such as:  

• one type of club by different manufacturers  
• one club type and manufacturer but different shaft flexes 
• one club but different manufacturer or type of golf ball 
• one club but different grip sizes 

 
The text descriptions typed in these fields carries forward to the remaining screens and 
the Session Summary Report.   
 
To the right of the Item list is the Average Reading table.  This table will be populated for 
each of the items as data is generated during the session.  Averages are calculated for any 
number of shots up to 10 shots total for each item.  The program allows more than 10  
shots to be hit, but data for the 10th shot will be overlaid for the purpose of computing the 
average.   
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At the bottom of the tab is the Recommendations block.  Recommendations and notes for 
the session may be entered here, based on data visible in the Average Reading table.  The 
Recommendations text block is shared with the Data Tables tab for ease of access.  Text 
entered into this block prints on the Session Summary Report. 
 

Recording Shots in a PureLaunch Session 
 

The Shot tab contains check boxes for the four items being tested.  Checking the box 
allows shots to be recorded for that item.  The shot counter will advance after each shot is 
hit, up to a count of 10.  As indicated, shots after 10 for an item replace the 10th shots’ 
data. 
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Position the golfer and launch monitor as shown.  The PureLaunch can be used indoors or 
outdoors.  If using indoors with a net, ensure at least 12 feet of clear ball flight from tee 
position to the net, in order for sufficient data to be gathered to record measurements. 
 

 
Once the golfer is in position to hit the shot, you must ARM LAUNCH MONITOR using 
the button near the bottom of the Shot tab.  Clicking this button will activate the radar, 
after which the PureLaunch waits to “hear” the club impact the ball via the integrated 
microphone.  When armed, the green LED indicator labeled ARMED lights up and the 
unit waits for the impact trigger.  After the monitor hears the impact, the PureLaunch 
tracks the flight of the ball and displays measurements.  
 
 

***ATTENTION***ATTENTION***ATTENTION***ATTENTION*** 
 

In some situations, clicking ARM LAUNCH MONITOR results in the following error.   
 
 
You may receive this 
error message if, while the 
PC and PureLaunch are 
connected, you shut off 
power to the PureLaunch 
launch monitor, or to your 
laptop.  If this occurs, you 
may lose communication 
via the USB port.  To reestablish connection, shut down the PureLaunch application, power 
off the PureLaunch unit, then back on.  Then restart the PureLaunch program. 

 
 

The front edge of the PureLaunch is 
positioned five feet, or 60 inches, 
behind the golf ball, pointed down 
the target line as shown.   
 
Ensure the golfer’s feet and the 
bottom of the launch monitor are in 
approximately the same horizontal 
plane, i.e., one is not higher or lower 
than the other.   
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***ATTENTION***ATTENTION***ATTENTION***ATTENTION*** 

 
To conserve battery power, the PureLaunch disarms 
itself if not triggered within 30 seconds of being 
armed.  If this occurs, a communication timeout 
error message is displayed.   
 
The error can be cleared by simply clicking OK and 
re-arming the monitor by clicking the ARM 
LAUNCH MONITOR button at the bottom of the 
Shot tab.  
 

 
 
 
Once the PureLaunch is successfully armed and a shot is hit, you will see measurements 
displayed on the Shot screen, as shown in this example. 
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Data Displayed in Shot Tab:   
 

• Club Speed is speed of the club head at impact, in miles per hour. 
• Ball Velocity is speed of the ball after impact, in miles per hour. 
• Launch Angle is angle of flight from horizontal, in degrees. 
• Ball Spin is total spin, in revolutions per minute (RPM). 

o PureLaunch measures ball spin when the golfer 
hits a ball with a ¼” reflective adhesive strip 
around it’s circumference as shown, initially 
placed perpendicular to the target line. 

 
o PureLaunch calculates ball spin when it does not see a reflective strip 

on the ball. 
 

• Distance is Carry Distance (distance the ball flies in the air before hitting the 
ground), in yards; PureLaunch measures distances for shots with 60 yards 
carry and above 

• Power Transfer Ratio % is calculated as Ball Velocity / Club Speed x 100%, 
an indication of centeredness of impact between the ball and club face.  An 
exception to this rule is the thin or topped shot, which may show a high ratio 
even though off-center impact was made.   

 
The shot can be deleted from the Shot tab immediately after it was hit using the Delete 
Shot button on the bottom right side of the screen, or at any point thereafter by selecting 
the Shot # from the shot counter and hitting the Delete Shot button.  Make certain you are 
in the appropriate test item before you delete shots.  If a shot is deleted by mistake, 
choose the Undo Delete option from the Edit menu. 
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Reviewing Shots in a PureLaunch Session 

 
The Tables tab displays measurements for all shots recorded in each test item in the 
session.  The bottom two rows in each table show the average and standard deviation for 
each set of data.  These averages are also displayed in the Average Reading table on the 
Session tab. 
 
You may write text in the Recommendation block on this tab or on the Session tab.  This 
text will print on the Session Summary Report printout. 
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Summarized Graphical Results from a PureLaunch Session 

 
Average measurements for each test item are displayed graphically and in tabular form 
on the Summary tab.  The test items are shown in different colors, with the color of the 
item corresponding to the color of the line on the graph.  In the following example, the 
red line on the graph shows the average of the measurements for the “Title 9.5 degree” 
shots. 
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Managing Files 

 
In the File menu, the software allows you to save your sessions.  You may accept the 
default file name 
(date plus time) or 
rename it.  Files are 
saved in the default 
file location as 
defined in the 
Software Setup 
window, or you can 
override the default 
location as desired.   
 
Once the session is 
saved, it can be 
reopened at any 
time by selecting 
Open from the File 
menu.  
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Printing the Session Summary Report  

 
Selecting the Print option from the File menu will print the 2-page Session Summary 
Report as shown.   
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Troubleshooting and Q&A 

 
1) Ensure the ball is 60” in front of the leading edge of the base of the PureLaunch. 
2) Ensure the golfer’s feet and the base of the PureLaunch are in the same horizontal 

plane, i.e., neither is higher or lower than the other. 
3) For measuring ball spin, ensure the reflective strip is ¼” wide, completely covers 

the circumference of the ball, and is positioned perpendicular to the target line 
before being hit. 

4) If there are more than four (4) items to test, one method is to use multiple sessions 
and relate them with similar filenames to keep track. 

5) If one or more measurements fail to display on the Shot tab after a shot is hit, 
PureLaunch could not gather a sufficient amount of data for the shot.  This could 
be the result of ambient electrical noise or other interference with the radar signal 
on that shot, such as the golf club coming back in front of the unit soon after the 
ball is struck. 

6) Occasionally, shots hit with the wedges and short irons may not create a loud 
enough sound to trigger the PureLaunch.  This could be the result of slow club 
speed and/or hitting the ground behind the ball. 

7) Outside of the PureLaunch v1.1 program, there are no settings that need to be 
changed by the end user.  Doing so will cause unpredictable and invalid results. 

8) There are no field replaceable or serviceable parts in the PureLaunch monitor.  
Removing the radomes or processor cover voids the warranty.   

9) Q:  Can I position the PureLaunch to the right or left of the target line?  A:  This is 
not recommended since it may adversely impact the ability to make accurate 
measurements.  

10) Q:  Can I swap out the computer I use with my PureLaunch?  A:  Yes, you simply 
need to install the software and drivers on whatever computer you wish to use 
with the device (prior to connecting the USB cable). 

11) Q:  Can I use the software with previous versions of Windows, like Win95, 
Win98, Windows/NT or Macintosh?  A:  The PureLaunch software is not 
certified and is not supported on these operating systems. 

12) Q:  Can I set my display settings to 600 x 800 screen resolution?  A:  PureLaunch 
screens are designed for 1024 x 768 pixel resolution at a minimum. 

13) Q:  Why does my Power Transfer Ratio % sometimes look good for topped shots?  
A:  Topped (also called thin or bladed) shots can be launched very quickly 
relative to club head speed, but with topspin (which causes the ball to dive into 
the ground) instead of backspin (which causes the ball to lift).  Since PTR% is a 
function of only two factors, ball velocity and club head speed, topped shots may 
show a high ratio even though other aspects of the ball flight (e.g., spin and 
launch angle) are undesirable.  The user can delete these shots as desired, using 
the Delete Shot button on the Shot tab. 
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14) Q:  What if some of the measurements displayed are clearly not accurate for the 
shot I just hit?  A:  Check your setup and ensure monitor, golfer, and ball are in 
the correct positions.  If setup is correct and measurements are still out of bounds, 
contact us.  It is possible that software corruption has occurred and is causing 
invalid results to be displayed. 

15) Q:  What other items might help me use the PureLaunch in the field?  A:  Three 
items that we have used include a laptop stand, laptop screen shade, and a 6’ tape 
measure. 
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Warranty 

 
This warranty applies only to the original purchaser of this product. 
 
Subject to Obligations or Exclusions found below, this Zelocity PureLaunch is warranted 
against manufacturing defects in materials and workmanship for the period of one year 
for parts and labor. 
 
This warranty includes telephone technical support and software upgrades at no charge 
for the PureLaunch product for the period of one year. 
 
Each warranty period commences on the date of purchase by the original purchaser.  
Warranted services must be performed at the Zelocity Corporation factory or an 
authorized Zelocity Service Center.  The warranty will be voided should anyone other 
than the Zelocity factory or an authorized Zelocity Service Center service the product or 
open the product casing. 
 
 

Obligations & Exclusions 
 
Zelocity Corporation will, at its option, repair or replace the defective product at no 
additional charge except as set forth below.  If the returned part is not found to be 
defective, then no warranty work will be preformed.  Repair components, parts and 
replacement products will be furnished on an exchange basis and will be either 
reconditioned or new.  All replacement parts and products become the property of 
Zelocity Corporation.  This warranty does not include service to repair damage as a result 
of modification of the product, misuse, abuse, neglect, negligence, vandalism, accident, 
or abnormal conditions including but not limited to war, flood, accident, lighting, fire, 
wind, or other acts of God or damage caused by occurrences over which Zelocity 
Corporation has no control. 
 
No charges for time or materials used in making repairs or corrections by parties other 
than Zelocity Corporation will be paid by Zelocity Corporation.  The warranty is void if 
any improper alteration or service is performed without written authorization from 
Zelocity Corporation. 
 
This warranty will be honored only upon presentation of the original, dated bill of sale. 
 
If the equipment has been connected to an incorrect power source, or is improperly 
installed (if applicable) by a party other than Zelocity Corporation, the warranty is 
voided. 
 
This warranty shall not cover adjustment of customer-operated controls or products that 
have been altered, replaced or have missing serial numbers.  This warranty shall not 
apply to uncrating, setup, installation or the removal and installation of products for 
warranty. 
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Warranty service may be obtained by delivering the product or component part to 
Zelocity Corporation’s service center.  If this product is delivered by mail, you agree to 
insure the product or assume the risk of loss or damage in transit, to prepay original 
shipping charges to the service center location and to use the original shipping container 
or equivalent.  Repaired products will be returned to you by surface delivery at Zelocity 
Corporation’s expense or by air freight at buyer’s expense. 
 
All expressed and implied warranties for this product including the warranties of 
merchantability and fitness for a particular purpose are limited in duration to a period of 
one year from the date of purchase, and no warranties, whether expressed or implied, will 
apply after this period.  Some states do not allow limitation on how long an implied 
warranty lasts, so the above limitations may not apply to you. 
 
If this product is not in good working order as warranted above, your sole remedy shall 
be repair or replacement as provided above.  In no such event will Zelocity Corporation 
be liable to you for any damages, including lost profits, lost savings or other incidental or 
consequential damages arising out of the use or inability to sue such a product, even if 
Zelocity Corporation has been advised of the possibility of such damages or for any claim 
by any other party. 
 
The foregoing in lieu of all other expressed warranties and Zelocity Corporation does not 
authorize any party to assume for it any obligation or liability.  In no event shall Zelocity 
Corporation be liable for special or consequential damages arising from the use of this 
product or anything other than its expressed purpose or for any delay in the performance 
of this warranty due to causes beyond Zelocity Corporation’s control. 
  
 

***CAUTION***CAUTION***CAUTION***CAUTION*** 
 

MAKING CHANGES OR MODIFICATIONS TO THIS PRODUCT,   
 

UNLESS EXPRESSLY APPROVED BY ZELOCITY CORPORATION, 
 

MAY VOID THE RIGHT TO OPERATE THIS EQUIPMENT. 


